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Chapter 1: 

Introduction to the Microsoft Excel Spreadsheet 
 

Objectives 
This chapter introduces you to the Microsoft Excel spreadsheet. You should gain an 

understanding of the following topics: 

 The range of uses of a spreadsheet 

 The basic elements of an Excel spreadsheet 

 Manipulation of an existing spreadsheet 

 Use of formulas to calculate values 

 How to develop a simple spreadsheet of your own 

 

Preparation 
In order to complete this chapter in 3 hours it is necessary for you to have a clear idea of 

your objectives. This chapter will introduce a number of different spreadsheet models 

that you will modify in some way. In each case you will need to understand certain 

principles demonstrated by the models. You will also be led step by step through the 

development of a new Excel spreadsheet. It will not be enough for you to just ‘follow the 

steps’. The ideas and techniques introduced here are building blocks for future exercises 

and you should make every effort to understand what you are doing and why you are 

doing it, rather than just following the steps. 

 Read the whole of this lab carefully 

 

Introduction 
This chapter has two parts. In the first part you will see some prepared spreadsheet 

models which illustrate the fundamental ideas of a spreadsheet and the range of uses to 

which it can be put. In the second part you will develop a simple spreadsheet model 

yourself. 

 

Starting Microsoft Excel 
Refer to the section on launching applications in Chapter 0. 

 

A window resembling Figure 1.1 should appear after Excel has launched. You won’t be 

using the new spreadsheet that appears but it is worthwhile examining some of the 

features of the Excel application before closing this new worksheet. 
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The most obvious feature is the array of rows and columns that constitute the worksheet. 

Notice that the columns are labeled with letters across the top of the worksheet (A 

through to K are visible) and that the rows are labeled with numbers down the left-hand 

side (1 through to 23 are visible). These column and row labels form a primitive method 

of naming each cell on the worksheet – B6 for example is the name of a cell in the B 

column six rows down. Such names can be used in formulas, although we’ll see better 

ways to name cells later on in this chapter. 

 

Figure 1.1 the Excel 2010 window at launch 
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Entering Data into Cells 
The second feature you should note is that one of the cells is highlighted with a black 

border. You can’t see it in Fig. 1.1 but on your computer screen it should be cell B6. 

Point to any other cell with your mouse and click once. This changes the highlighted cell. 

Notice that the label in the area just above the worksheet on the left of the window 

contains the name of the selected cell: 

 
 
Type anything you like (your name perhaps) into the cell that you selected – i.e. just start 

typing and you will see whatever you type appear in the cell. At the same time whatever 

you type will appear across the top of the worksheet – in an area that is called the formula 

bar: 

 
 

When you have finished typing press the Enter key and observe what happens to the 

cells on the worksheet. Do the characters you typed exceed the cell width? Experiment 

with entering large and small amounts of text in different cells. 

 

Next select a different cell and this time type a number and press Enter. What do you 

observe about the placement of numbers as opposed to small amount of text in a cell? 

 

Other Worksheets in the Workbook 
Next observe at the bottom of the screen that there are tabs labeled Sheet1, Sheet2 

etc. Currently Sheet1 is highlighted but if you now click on one of the other sheets you 

will go to another worksheet of cells. This other worksheet is currently empty. Click on 

Sheet1 to go back to the one on which you typed some data. There can be many 

worksheets in a spreadsheet model, with formulas linking them together. 
 

 
 

Notice too the arrows next to the sheet tabs, which allow you to move forwards or 

backwards through the various sheets. 

 

 

The Excel 2010 Ribbon Interface 
With Excel 2007 Microsoft replaced the Command Menu and Toolbar with a "Ribbon" 

interface. Click on a tab on the top line (Home  Insert  Page Layout  etc.), and a set of 

commands appears in the form of a ribbon below: 
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Closing the Workbook 
You don’t want to use the workbook you have been playing around with. This has just 

been a brief tour of the Excel application interface. You should now close this workbook 

so that you can begin to examine the demonstration models. There are two ways to close 

a workbook – you can either choose the Close command in the File tab or you can click 

on the x button in the top right hand corner of the workbook window. If you chose the 

latter method be careful to click on the x in the workbook window, which is the lower set 

of window controls. Do one of these now. 

 
 

You’ll find that a dialogue window appears asking if you want to save the workbook - 

you should click on Don’t Save: 
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Exploring Some Spreadsheet Models 
 

Download files from the course website 
 

To locate the following Demonstration Models, go to the course website and click on the 

"Resources" button, then select "Support Files" and then "1".  Save the files to your 

computer for future use. 

 

 

Opening an Existing Spreadsheet 
 

There are potentially two ways of opening an existing spreadsheet. One is to use the 

Open command from the File tab. Another is to locate the file and double-click on it. 

This time you will have to use the first way. 

 

An Open dialogue window will appear and you should navigate through the file system to 

the folder containing the lab materials. Refer back to Chapter 0 if you have forgotten how 

to do this. 

 

 

Demonstration Model 1 
 

The model you have just opened contains two worksheets. The names have been changed 

from Sheet1 and Sheet2 to Comments and Summing; and the Comments worksheet 

is the one displayed. 

 

The Comments Worksheet 

This worksheet contains a brief description of the purpose and features of the spreadsheet 

model. It illustrates a documentation principle that you should follow in all of the 

spreadsheet work you do. Documentation of your work is crucial – not only for other 

people who may need to understand or modify it, but also for yourself when you return to 

it after a few weeks or months and find that you have forgotten what you did. 

 

The Summing Worksheet 

This worksheet is shown in Fig. 1.2. It shows three methods of adding a row of numbers. 

The first thing you should do is examine the contents of the cells by selecting certain 

ones. For example, select the cell B1. It looks like it might have the characters “ a l” – 

i.e. part of “a list” in the cell. However, you can see from the formula bar that cell B1 

is actually empty. Select cell A1 and you will see the entire first row displayed in the 

formula bar. 
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Figure 1.2 the Summing worksheet in demonstration model 1 

 

 
 

Select cell B6 and you will see that it contains the number 6. Select cell H6, however, 

and you will see not the number 34 displayed in the formula bar but rather a formula, 

which has the value 34 as its result from adding the values in the row. Examine the 

formulas that calculate the other sum values and observe their differences. 

 

Changing Values on the Spreadsheet 

Select one of the numbers in a row and type a new value, pressing Enter when you’ve 

done. Notice that the sum value is instantly changed to reflect the new value. This 

interactive feature of a spreadsheet is one of the reasons spreadsheet programs are such 

valuable tools in so many problem solving applications. 



COSC1520.03  Glade Manual  

Computer Use: Fundamentals 
 

 

 

   

   

 1-7 

 

Inserting a Column (or Row) 

Add a new column to the spreadsheet so that a new number can be included in the row 

that is being summed. To do this, select one of the columns C, D, E, F, or G by clicking 

on the letter in the top row of the worksheet. Then from the Home tab, click on Insert 
within the Cells Group.  A new empty column should appear to the left of whichever 

column you had selected. A row may be inserted in the same manner – that is, by 

selecting a whole row by clicking on its number on the far left (you’ll select the row 

below where you want the new one to appear) and from Home, click on Insert within 

Cells. 

 

The Generality of Formulas 

Now select the new cell in one of the rows of numbers and type a new value that you 

would like to be included in the sum. Do this for each of the three rows of numbers 

observing in which cases the value for the sum also changes. One of the formulas gives 

the wrong answer when this new value is inserted, and hence you should draw the lesson 

that this type of formula should be avoided. Delete the new column you inserted once you 

have done this. 

 

Naming a Range of Cells 

Click on the little downward pointing arrow to the right of the name bar (on the left of the 

window just above the column headings A, B, C etc: 
 

 
 

You’ll see a single name, Values, appear. Click on that name and observe that the third 

row of numbers is highlighted. This row of numbers has been defined to have the name 

Values in this model. It is possible to name single cells or groups of cells like this. The 

aim is to define easily remembered names for data in your worksheets. These names can 

then be used in formulas so that they are easier to read, rather than having only cell 

references such as B13 or whatever. 

 

Click on the Sum value for this row and observe that the formula that calculates this 

value uses the name Values. 

 

Functions 

The formulas for the sum in methods two and three also use a function – the SUM 

function. Functions take the general form of 
 

SomeFunctionName( someArgumentList ) 
 

You’ll use various functions extensively in later chapters. For now notice that the SUM 

function has as its argument list a single value expressed as either a range of cells 

The name bar: 
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(B12:G12 for example) or the single name, list, representing a range of cells. This is the 

most common, although not the only way, of using the SUM function. Other functions 

might have more than one argument with the arguments separate by commas. 

 

Demonstration Model 2 
 

Close the previous spreadsheet model (you don't need to save it) and open the one called 

Demonstration Model 2. Read the Comments worksheet carefully before you switch to 

the second worksheet called DataSheet. The DataSheet worksheet is shown in Fig. 

1.3. 

 

Figure 1.3 – the DataSheet worksheet from demonstration model 2 
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This worksheet demonstrates a number of new methods of making calculations, as well 

as a few new functions. The raw data on this worksheet – that is the data that is entered 

by hand and therefore not calculated by formulas – is contained in the columns labeled X 

and Y. Names have been created for these two columns. Click on the arrow in the Name 

Box and select first X and then Y to see what they refer to. 

 

Copying Formulas – the Fill Command 

The data in the other columns labeled X+Y and X*Y is created very easily, even though 

apparently a lot of formulas are involved. Select the cell D6 containing the value 10 and 

you’ll see that it is calculated by the formula B6+C6. The other cells in this column are 

essentially calculated using the same formula except that the row numbers change. 

Examine a few of them. These formulas are created very easily by first typing the top 

formula, then selecting that cell and all of the others in the column (which are empty at 

this point) to which you want the formula to apply, and then choosing from Home tab the 

Fill/Down command within Editing group. This command copies the top formula into all 

of the selected cells, changing the row numbers as appropriate. The other columns of 

calculated data are created in essentially the same way – one formula was typed for the 

top cell, and then filled down the column.  

 

Using Named Ranges in a Formula 

Examine the formulas for the first X*Y column. The names X and Y refer to the whole 

columns (as you observed in a previous section) and here the same formula is filled down 

the X*Y column to calculate all of these values. Although the names refer to the whole of 

the X and Y columns the formula “knows” to use just the two X and Y values on the same 

row in order to calculate any particular X*Y value.  

 

Some New Functions 

This worksheet also introduces some additional functions in order to familiarize you with 

their use. You’ve seen the SUM function before – and now you can see the MIN, MAX, 

AVERAGE and MEDIAN functions, all using a column of data as their argument. The 

column is either expressed as a range of cell references or as a named range. Close the 

worksheet before you move on to the next example (there's no need to save it). 

 

Demonstration Model 3 
 

Open Demonstration Model 3. This model implements a slightly more complex formula 

than the previous examples, and also demonstrates the use of the graphing capabilities of 

a spreadsheet. 

 

The model calculates the distance an arrow will travel if fired with an initial velocity and 

an initial angle, and assuming the ground is perfectly flat. The initial velocity is treated as 

a parameter – that is, it is held constant while the initial angle is varied and the distance is 

calculated for each angle. 
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The model has three worksheets – the Comments worksheet (read it carefully), the 

Parameters worksheet (Figure 1.4) and the Trajectory worksheet (Figure 1.5). Besides 

the initial velocity the Parameters worksheet also contains the other constant quantity – 

the gravitational constant. (Notice that the units are included in a cell adjacent to the 

value.) 

 

Figure 1.4 – the Parameters worksheet in the Flight of an Arrow model 

 

 
 

The Trajectory worksheet (Figure 1.5) contains a column of values for the initial angle 

and a column of values for the calculated distance the arrow travels, as well as a graph of 

the relationship. 

 

Nested Functions 

The formula to calculate the distance the arrow will travel is: 

distance = velocity2 * sine( 2*angle ) / g 
 

Click on one of the values in the Distance column in the Trajectory worksheet and 

observe the formula as it is expressed in Excel. In this formula two functions are used – 

but one of them is nested within the parentheses of the other. The formula is: 

=V*V*SIN(2*angle*PI()/180)/g 
 

Launch Angle is in degrees (you can see this in the worksheet) but the SIN function 

expects the angle to be in radians. Therefore, the angle is converted by multiplying by 



COSC1520.03  Glade Manual  

Computer Use: Fundamentals 
 

 

 

   

   

 1-11 

pi/180. And pi is represented by the second function  - PI(). Notice that the function PI() 
does not have any arguments, as indicated by the empty parentheses – it simply produces 

the value of pi as its result. 

 

Inter-Worksheet Formulas 

The formula that calculates the Distance values in the Trajectory worksheet uses the 

named values V, angle, and g. However, V and g refer to values that are in a different 

worksheet, the Parameters worksheet, and hence the formula is actually what we will 

call an inter-worksheet formula. 

 

Use Formulas/Name Manager to open the Name Manager window to see the list of 

names.  You’ll see that the cell reference is prefixed by the worksheet name – 

Parameters! in this case. This method of specifying a cell or range as coming from a 

particular worksheet is part of the syntax of Excel formulas. Take careful note of this 

syntax because you'll meet it frequently and sometimes you might want to be able to type 

it out yourself. Close the Name Manager window again. 

 

A Graph 

Graphs of many different types can be created by a spreadsheet program – and either 

placed next to data on a worksheet (as in this example) or placed on a separate worksheet 

of their own. One interesting feature is that the graph is interactive in the sense that it is 

redrawn immediately if you change any of the data from which it is derived. 

 

Observe the maximum distance that the arrow can travel (it is about 7.5m for an initial 

angle of 45 degrees) and then switch to the Parameters worksheet where you can change 

the value of the Initial Velocity. Type a new value and return to the Trajectory 

worksheet. You should see that the graph has changed to reflect the new data. 
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Figure 1.5 – the Trajectory worksheet in the Flight of an Arrow model. 
 

 
 

Demonstration Model 4 
 

Open Demonstration Model 4. This model contains 4 worksheets – the Comments 

worksheet; a worksheet containing a graph and values for the initial velocity and angle of 

a canon ball fired over a hill; a Parameters worksheet containing values which define 

the shape of the hill (and the gravitational constant); and a Hill_and_Projectile 

worksheet containing the data that is to be graphed. The graph is shown in Figure 1.6. 
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Figure 1.6 – the Canon Ball Trajectory 
 

 
 

The main new feature of this model is the ease with which the model parameters can be 

adjusted in order to achieve some objective. The objective in this case might simply be to 

have the canon ball hit the far right corner of the land (i.e. where the black line reaches 

the edge of the graph). One approach is simply to change the velocity and/or angle 

parameters hoping by trial and error to hit the corner. Try this now. 

 

New Functions and Operators 

Besides this goal seeking demonstration the model also provides examples of the use of 

yet more functions. Examine the formula for the Z column and you’ll see the use of the 

EXP function (which calculates the value of e
x
, where x is the argument of the function). 

The formula that calculates the Hill Height column demonstrates the use of the 

exponentiation operator, ^, and the Projectile Height formula shows the use of further 

trigonometric functions, TAN and COS, in a fairly complex expression. 

 

Demonstration Model 5 
 

Open Demonstration Model 5. This model demonstrates the capability of a spreadsheet to 

analyze (in this case statistically) a large set of data, and to present the results visually. 

The model simulates the rolling of two dice and presents simple statistics (frequency 

counts) of the sum of the numbers on the two dice. 
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There are three worksheets in the model – a Comments worksheet, the dieValues 

worksheet which contains the values on the two dice and their sum, and a Countif 
worksheet which demonstrates one possible way of calculating the frequency counts. 

 

The RAND Function 

Select the dieValues worksheet and examine the formula that calculates a die value. It 

uses nested functions again. The RAND() function produces a random number between 0 

and (less than) 1, which must then be multiplied by 6 and converted to an integer in order 

to obtain a value between 0 and 5 inclusive. The INT function does the conversion to an 

integer. Add one to produce the values on the dice. 

 

The COUNTIF Function 

To count the frequency of each possible roll of the dice, we list the possible values first 

(i.e. the values 2 to 12) and use them as a criterion by which to decide whether to count a 

particular value. The COUNTIF function uses the possible value of the sum of the dice in 

order to decide whether to include a value from the long list of dice “throws” in the 

frequency count for that possible sum value.  

 

Select the first value in the Frequency column and examine the formula.  It should be 

 

=COUNTIF(dieValues!$C$2:$C$701,Countif!A3) 
 

Looking at the last argument first, namely Countif!A3, observe that this refers to the first 

value in the Sum column, i.e. 2. The first argument refers to the large column called Sum 

in the dieValues worksheet. Thus this function arrives at this first value in the Frequency 

column by counting those values from the dieValues!Sum column which equal 2. 

 

 

Exercise 1 - Making a New Spreadsheet 
 

This exercise will walk you through the development of a simple budget spreadsheet. 

Any similarity to your real budget is purely coincidental!  

 

Assuming you have Excel running, close any open workbooks. To open a new, blank,  

workbook, click on the File tab, then click New and under Available Templates, 

double-click Blank Workbook. (Or exit Excel entirely and restart it.) You should see a 

window similar to Figure 1.1. 

 

First, change the names of the worksheets. Double click on the Sheet1 tab to highlight 

the word Sheet1 and then type the new name – Comments in this case. Do the same 

with Sheet2 renaming it MonthlyBudget. You should delete the third worksheet by first 

selecting it and then clicking on the Home tab, followed by clicking on Delete in the 

Cells group and then finally clicking on Delete Sheet. 
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The Comments Worksheet 
A Comments sheet is essential to any well designed Excel model. It should include a 

brief description of the model you are about to create. You will probably want to revise 

the comments worksheet after you have written the monthly budget worksheet – but it is 

important to be able to write part of the comments worksheet first so that it serves as a 

plan that you can follow in writing the rest of the model. 

 

The aim of this model is to list your sources of income and subtotal them, to list your 

expenses and subtotal them, and finally to calculate the surplus (or deficit). This is to be 

done for the months May to August. The end result, without actual dollar amounts 

entered, is shown in Figure 1.8. 

 

The Monthly Budget Worksheet 
Figure 1.8 – the Monthly Budget worksheet 

 

 
 

Entering and Formatting the Month Names 

Enter the month names in the first row of the MonthlyBudget worksheet. A simple way to 

do this is to type just the first month in the appropriate cell (C1). Then click on the lower 

right corner of the cell border and drag it to the right across the other 3 cells. You must 

carefully point to the corner of the cell containing May. You'll see the cursor change 
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shape to a cross (+) when it’s in the right position. You should see the other month names 

appear as you drag. Figure 1.9 shows how this should look as you start. 
 

Figure 1.9 – dragging the fill handle 
 

 
 

Now you should format the month names – select the four cells (by dragging across 

them) and then use the Font, Alignment and Number groups in the Home tab to change 

the font size and/or type, and to make the text bold or italicized, etc. The font type is 

currently Calibri. Click on the arrow to the right of the font name and select a different 

font if you want to. The size, currently 11, can be changed in the same way. Clicking on 

the other icons once will cause the formatting changes indicated. 

 

You might also need to change the width of the columns if the words exceed the default. 

To do this, carefully position the cursor over the boundary between two columns (the 

cursor will change shape to a vertical line intersected by a horizontal line with double 

arrows:          ) and drag the column boundary to make it wider. If you select all four 

columns containing the month names their widths can be changed at the same time. 

 

Income and Expense Items 

Type all the Income and Expense headings as indicated in Figure 1.8. You can include 

other types of income and expense if you want. Format the data to enhance its clarity and 

readability and also adjust the column widths appropriately. 

 

Creating the Formulas 

The three rows Total Income:, Total Expenses:, and Monthly Surplus (Deficit): are 

the only ones, which contain calculated data. You must enter the rest of the data – it 

being the “raw data” of the model. 
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The total income for each month is just the sum of the income amounts for that month. 

You should use the SUM function with the argument being the range of cells in the 

column above. To do this, select the cell for total income for May and then click on the 

function icon in the formula bar.  

 

A window displaying the list of functions available in Excel appears and you should 

select the Math & Trig collection of functions amongst which you’ll find the SUM 

function (see Figure 1.10).  

 

Figure 1.10 – the Insert Function window 
 

 
 

Click on the OK button and the function is entered in the formula bar and a panel appears 

that helps you fill in the argument (Figure 1.11). In this panel the text box labeled 

Number1 should have the cursor in it indicating that this is where text will appear. The 

argument (i.e. the cell range representing the values you want to sum) should be the 

column of income amounts for May. Drag the panel out of the way if you have to so that 

you can select the cells containing income amounts for May (by dragging over the cells). 

Notice that the range you select appears in the Number1 text box. Click OK once you 

have done this. 

 

 

 

 

 

 

 

The function icon: 
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Figure 1.11 – the SUM function argument window 
 

  
 

The next step is to replicate this formula for the other months. This is easily done by 

dragging the fill handle across the three rows just as you did when entering the month 

names. This time, however, as the formula is filled across the row it is changed to specify 

the correct column letter for each column.  

 

The formula for the Total Expenses: row is created in the same way.  

 

To create the formula for the Monthly Surplus (Deficit) row you should first select the 

cell for the May column, type an = symbol, then click on the total income cell for May, 

type a – (subtraction) symbol and then click on the total expenses cell for May. As you do 

these various operations observe that the cell references are entered into the formula. 

Pointing and clicking is probably the easiest way of specifying the formula although you 

could also type it yourself if you were familiar enough with the syntax of Excel.   

Note: Point-and-Click is the definitely the best way to go. 
 

Entering and Formatting Data 

At the moment there are no amounts entered for any income or expenses. The values 

calculated by formulas will therefore be zeroes. You should now enter any sensible 

values for income and expense amounts and perform any remaining formatting to make 

your worksheet resemble Figure 1.8. You’ll have to explore the various possibilities 

represented by the icons in the formatting tool bar (Home tab and Font, Alignment and 

Number cells within it) – but you have the basis for discovering these possibilities for 

yourself now. Remember that the numbers in this worksheet are all dollar amounts and 

should therefore be formatted as such. Make sure you do this. Close the workbook 

making sure that you save it - you might first want to create a folder called Ch1, say, in 

which to save the work you do in this lab. 
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Exercise 2 
 

Create the following spreadsheet in which the values of the Sum and Product columns 

are calculated by formulas. The first value in the Sum column is the sum of  4, 7 and 8 

for example. Make sure you do it in such a way that if you were to add a fourth or fifth 

column of numbers the formulas still calculate the correct values. Can you figure out how 

to center the title Test Values across the columns? 

 

 

 

 

Exercise 3 
 

Create the spreadsheet shown in Figure 1.12. This spreadsheet calculates the graph of the 

cosine function. There is a column of at least 50 values for the angle (in degrees) and a 

column for the value of the cosine of the angle. 

 

Figure 1.12 – the cosine function model 
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Filling with a Series 

There are at least 50 values for the angle and you should not enter them by hand. Neither 

can you enter them using the fill handle as you did for the month names and the formulas 

in the budget model.  In this case you must enter the first value and then select the 

column range, including the first value you just entered, that you want to fill with the 

other values for the angle – making sure it is at least 50 cells. Select the Home tab, and 

then click on the arrow (triangle) next to the Fill command, which is located in the 

Editing group at the right end of the command ribbon, and select the Series... option. 

Examine the choices you can make in this window carefully. Except for the Step value: 
box you don’t need to change any of the choices, but you should at least try to remember 

what options the series fill provides. Change the step value to 10 and click OK. Observe 

how the column of values for the angle is filled.  

 

Figure 1.13 - the Series fill dialogue panel 

  
 

Calculating the Cosine 

This can be done by writing the formula for the first cell and then filling down the 

column by dragging the fill handle (that little square in the bottom right corner of the 

border around the cell that is selected). Select the first cell and use the function icon to 

activate the Insert Function window (Figure 1.10). You’ll find the COS function amongst 

the Math & Trig functions and you can specify the argument by clicking on the adjacent 

cell containing the angle value. The angle values are in degrees but the COS function 

expects radians so you must convert the angle value to radians by multiplying by π (pi) 

and dividing by 180. To do this simply type the multiplication symbol (the asterisk) and 

then click on the pull-down menu arrow in the name box. The name box currently 

displays the COS function name but a short list of other functions should appear and if 

you choose 

  

 The name box displaying the COS function: 
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More Functions…  you'll open the Insert Function window (Figure 1.10) and be able to 

select the PI function from the Math and Trig group of functions. The PI function simply 

represents an accurate value for π (pi). You'll see this next panel: 

 

   
 

Your inclination now is to click the OK button.  Do not click the OK button! At this point 

you have a function (PI) inside another function (COS).  What should happen when you 

click OK is a return to COS so you can complete that function.  That does not happen.  

Clicking OK in PI closes not only PI but also COS, which is still incomplete.  Rather than 

clicking OK in PI move the cursor back up to the formula bar and position it anywhere 

within the name COS in the expression in the formula bar and click the left mouse button.   

 

 
 

The Function Arguments window for COS now reappears: 

 

 
 

 

 

 

 

The name box and formula bar after 

inserting the PI function: 
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You can now finish the formula by including the division by 180. The Function 

Arguments window now looks like this: 

 

 
 

The formula is now finished so click OK and fill the formula down the column. You 

should get the results shown in Figure 1.12. Format the Cosine column to display only 4 

decimal positions. 

 

Creating a Graph 
 

Click on the Insert tab and select the Line command from the Charts cell and then select 

“All Chart types…”. 

 

 
 

The Insert Chart window shown in Figure 1.14 should appear. Observe the possible chart 

types carefully (select each of them to see all of the possibilities) but then make the 

selection shown in the figure – i.e. the first entry in the Line row – before clicking OK. 
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Figure 1.14 – the Insert Chart window 
 

 
 

An object in the form of an empty rectangle is placed on the current worksheet.  When 

complete the graph will appear in this space, as shown in Figure 1.12. 

 

The next step in the chart creation is to select the data.  Notice that the Design tab in 

Chart Tools is now showing.  

 

 
 

When you click on Select Data the Select Data Source window appears: 
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In the language of Excel Legend Entries (Series) are the values on the Y-axis, i.e. the 

curve in our case, and the Horizontal (Category) Axis is the X-axis.  

 

To create the cosine curve, select Add under Legend Entries and click OK. The 

following window appears: 

 

 
 

You can give the curve a name, but that is not necessary.  Erase the phrase ={1} in Series 

values and highlight cells B3 to B52 (or to the last cell containing a value) on the 

worksheet and click OK. 

 

 
 

Notice that the horizontal axis seems to bear no relation to the angles from which you 

calculated the cosine function value. In fact the horizontal axis seems to simply count 

how many values there are in the data. The next step allows you to specify which data to 

use on the horizontal axis of the graph.  

 

Click on the Edit button below Horizontal (Category) Axis Labels and select the angle 

data on your worksheet. 
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The next step is to specify a chart title, labels for the axes, and the legend, amongst other 

possibilities. A legend is useful if more than one line (series) is being plotted since the 

legend would identify the lines. 

 

In the Design tab, select the appropriate layout of titles (Chart Title across the top and 

Axis title along both the X- and Y- axis) from the Chart Layouts cell.  

 

 
 

You won’t find exactly what you are looking for, so choose one that has more than you 

need. You can later delete the unwanted parts. Click on each of these and change them to 

the titles shown in Figure 1.12. 

 

To delete an unwanted part, such as Legend, select the desired entry in the Labels cell 

in Layout within Chart Tools: 

 

 
 

Rather than use the pre-defined Chart Layouts you can also build the Labels one-by-one, 

if you prefer. 

 

Further Adjustments to the Chart  
 

The chart now needs some tidying up. For example, the numbers on the horizontal axis 

would be better if they were oriented normally, and there are too many of them. In 

addition, there are too many values on the vertical axis and those values certainly do not 

need to have such decimal figure precision. 

 

To further fine-tune the presentation of the plot you can select various features of it in 

order to make adjustments. For example, select a component in the chart by clicking once 

within its border (“handles” should appear on its border). You can resize it or move it.  
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Double-click on any of the values along the horizontal axis and the Format Axis window 

appears: 

 

Figure 1.15 – the format Axis window for the X-axis 
 

 
 

 

Type in the values shown in the figure and change other settings whenever they differ 

from the initial values and settings. Make sure you understand why these values were 

chosen. In fact, you would be well advised to experiment with different values to see the 

effects and make the changes one at a time and examine the graph after each one. 
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Next, double-click on any value on the vertical axis of the graph and adjust the 

parameters displayed in the Format Axis window, see if you can make your graph look 

like that shown in Figure 1.12. 

 

Figure 1.16 – the Format Axis window for the Y-axis 
 

 
 

Summary 
This chapter has given you an introduction to Excel spreadsheets. The techniques for 

creating a spreadsheet model and building formulas are fundamental to your future work 

with spreadsheets of any type. You must take the opportunity now to ensure that you are 

totally familiar with the principles discussed in this chapter, so please review the work 

and experiment with the many capabilities of the spreadsheet that have been introduced. 


